Mac and Windows compatible.

DJ software for mixing and analyzing tracks.

User Manual
Scratch DJ Academy MIX!

User Guide

Created by Scratch DJ Academy and Stanton Magnetics
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intro</td>
<td>7</td>
</tr>
<tr>
<td>Computer Requirements</td>
<td>7</td>
</tr>
<tr>
<td>Getting Started</td>
<td>8</td>
</tr>
<tr>
<td>Authorization/Licensing</td>
<td>11</td>
</tr>
<tr>
<td>Check for Updates</td>
<td>12</td>
</tr>
<tr>
<td>Library</td>
<td>13</td>
</tr>
<tr>
<td>Adding Your Songs / Importing</td>
<td>13</td>
</tr>
<tr>
<td>Limitations</td>
<td>15</td>
</tr>
<tr>
<td>Search</td>
<td>15</td>
</tr>
<tr>
<td>List View Options</td>
<td>16</td>
</tr>
<tr>
<td>Sorting</td>
<td>16</td>
</tr>
<tr>
<td>Auto-upgrade</td>
<td>16</td>
</tr>
<tr>
<td>Creating Playlists</td>
<td>17</td>
</tr>
<tr>
<td>Hints</td>
<td>18</td>
</tr>
<tr>
<td>BPM Matching</td>
<td>18</td>
</tr>
<tr>
<td>Key Matching</td>
<td>18</td>
</tr>
<tr>
<td>Genres</td>
<td>19</td>
</tr>
<tr>
<td>Using the Mix Controls</td>
<td>20</td>
</tr>
<tr>
<td>Mix #</td>
<td>20</td>
</tr>
<tr>
<td>Mix Point</td>
<td>20</td>
</tr>
<tr>
<td>Mix Length</td>
<td>21</td>
</tr>
<tr>
<td>Scratch FX</td>
<td>21</td>
</tr>
<tr>
<td>Cue</td>
<td>22</td>
</tr>
<tr>
<td>Preview</td>
<td>23</td>
</tr>
<tr>
<td>Record Mix</td>
<td>23</td>
</tr>
<tr>
<td>Using the Arrangement Timeline View</td>
<td>23</td>
</tr>
<tr>
<td>Waveform Clips</td>
<td>23</td>
</tr>
<tr>
<td>Selected Mix Region</td>
<td>24</td>
</tr>
<tr>
<td>Playback Marker</td>
<td>24</td>
</tr>
<tr>
<td>Timeline</td>
<td>24</td>
</tr>
<tr>
<td>Zoom Slider</td>
<td>24</td>
</tr>
<tr>
<td>Scratch FX Indicator</td>
<td>25</td>
</tr>
<tr>
<td>Dragging Waveforms</td>
<td>25</td>
</tr>
<tr>
<td>Dragging Mix Length</td>
<td>26</td>
</tr>
<tr>
<td>Transport Controls</td>
<td>26</td>
</tr>
<tr>
<td>Stop</td>
<td>26</td>
</tr>
</tbody>
</table>
Rewind – 27
Play/Pause – 27
Fast Forward – 27
Volume – 27
Pickup Cursor – 27
Scroll Slider – 27
Display Contents – 28

Saving and Recalling Your Work — 28

Recording Your Mix / Exporting — 29
  Record Mix Options – 29
  Saving the File – 29
  Mix Vault – 30

Song Information Window — 31
  Previous, Next, OK, Cancel – 31
  Info Editor (Tags) – 31
  Mix Settings Editor – 32
  BPM and Tap Feature – 32
  Groove – 33
  Key – 33
  Restore – 33
  Show Bars – 33
  Transport, Preview Song – 34
  First Bar Indicator, Song Start Offset – 34
  Zoom Slider – 34
  Tutorial: Graphically Setting the “1” Beat – 35

Scratch DJ Academy Lessons — 37

Preferences — 38
  General – 38
  DJ Name – 38
  Show Hints – 38
  Autoscroll to Playback Marker – 39
  Tags – 39
  Write to BPM Tag – 40
  Write to Beginning of Comments Tag – 40
  Write to Key Tag – 40
  Audio Setup – 40
  Output – 41
  Test – 41
Intro

Scratch DJ Academy, the world leader in DJ education, and Stanton present Scratch DJ Academy MIX! — an intuitive DJ software for beginner and professional DJs alike. Scratch DJ Academy MIX! is perfect for music fans that want to mix tracks from their personal music library, as well as professional DJs that need a song analysis and/or sequencing tool to help them refine their game.

While most DJ and music production software takes months or years to master, Scratch DJ Academy MIX! is an incredibly simple way to get the most out of your music. You can also learn the DJ basics along the way through Scratch DJ Academy’s award winning curriculum included in the app.

Scratch DJ Academy MIX! analyzes your music library and identifies each track’s Beats Per Minute (BPM), song structure, and musical key. This helps you to understand which of your songs may mix well together, and then Scratch DJ Academy MIX! intelligently recommends combinations of your tracks instantly. Scratch DJ Academy MIX! will help you automatically beatmatch and mix your songs — just like a professional DJ. The result is uninterrupted mixes that flow seamlessly from track to track without conflicting tempo and pitch.

Computer Requirements

Windows XP SP3, Vista, or Windows 7, or Mac OS X 10.5.7 or higher operating system with 150 MB free hard drive space and 1 GB of RAM or higher (2 GB recommended).
Getting Started

This section gives you an overview of the Main Window of Scratch DJ Academy MIX! Here you’ll learn the names and locations of the controls and their purpose. If you are a beginner, we highly recommend that you read the “Scratch DJ Academy Lessons...” Help menu feature (See page 37 Scratch DJ Academy Lessons) to learn about DJing and mixing and how Scratch DJ Academy MIX! applies all of these techniques.

To get started quickly, make sure your audio settings are correct in the “Audio Setup” tab of the Preferences. See “Audio Setup” in Section 14 for more details.

At First Glance - Here’s a look at how Scratch DJ Academy MIX! looks when you first launch the application:

![Scratch DJ Academy MIX! Main Window](image)

The Main Window includes the Library and Playlist views at the top, the Mix Controls in the center, followed by the Arrangement Timeline View and the playback Transport controls at the bottom. See the following page for a breakdown of each:
A. Library – The library comes preloaded with 10 free songs. All of your imported music is displayed here and can be searched and sorted. Click “Add Songs” to add songs from your personal music library.

B. Playlist - Drag songs from your library into the playlist view to create the perfect mix. When you select a song in your playlist, Scratch DJ Academy MIX! will show you what songs may mix well with each other by highlighting songs in your library with similar BPM (Beats Per Minute) and musical key. For each song added to the playlist, a new mix transition is added with default mix control settings.

C. Mix Control Panel - Use the mix controls to quickly change your mix transitions and preview your mixes. The mix transition is the overlapping section of the playlist where you hear one song end and another begin. Use the preview feature to hear each mix individually and tweak the settings until you get the perfect mix.

D. Arrangement Timeline View - The arrangement shows a timeline view of your playlist with a waveform representation of each of the songs. Here you can see where each of the songs overlaps in time and zoom in to see the beats align and make detailed adjustments until each mix lines up perfectly.

E. Zoom Slider - Drag the zoom slider to see a closer view of the arrangement. Zoom out to see more of the songs at once.

F. Transport - The transport controls playback of your mixed playlist, with play, pause, stop, rewind, and fast-forward controls.

The following chapters describe each of these controls with much more detail and all of the other features of Scratch DJ Academy MIX!
Authorization/Licensing

When you load Scratch DJ Academy MIX! for the first time, you will be prompted with a registration window to register your copy of the software. You must have an internet connection to complete the registration.

You can run Scratch DJ Academy MIX! in Demo mode, but saving your mix sessions and recording to file are not available in this mode. Also, Scratch DJ Academy MIX! will exit after running for 30 minutes when in Demo mode. You will be prompted with this window each time you load Scratch DJ Academy MIX! until you have registered your license key.

You can check your Registration status from the “Register your License Key…” option, located in the Help menu on Windows or “Scratch DJ Academy MIX!” menu on Mac.
Check for Updates

When opened, Scratch DJ Academy MIX! will automatically check the internet to see if there is a newer version of the software available. If there is a new version available and you choose not to update when prompted, you can always select “Check for Updates…” located in the Help menu on Windows or the “Scratch DJ Academy MIX!” menu on Mac to update at any time in the future.
Adding Your Songs / Importing

The Library is the place where you store your collection of songs. To import songs into the Library from your computer, you can use the “Add Songs” button (A) at the top of the Library pane or you can use the “Add Songs to Library…” selection from the File menu. You can also drag and drop songs from other locations on your computer into the Library.
After songs are selected for import, Scratch DJ Academy MIX! will perform a quick scan of each song to make sure that it is in a recognized format and will then add that song to the Library in a grayed out state, showing that it is presently “Importing…”

When songs are imported, they go through an analysis process which determines their tempo in beats per minute (BPM), musical bar lines, and key. These attributes are paramount to creating the perfect music mix, and professional DJs spend many hours figuring out the tempo, key, and bars for their songs. Scratch DJ Academy MIX! does this process automatically and will have you mixing your songs in just a matter of minutes.
The main analysis process occurs in the background, and the song that is currently being analyzed will show the percentage of analysis completed in the Length column of the Library list. Until a song is fully analyzed, it can not be dragged into the Playlist or edited in the Mix Settings window.

You can listen to any song in the Library by double clicking on it. Right clicking on a song will give you the option to edit its Song Information (see page 31).

The Library is automatically saved by Scratch DJ Academy MIX! and is available for all of your mix sessions.

**Limitations**

Scratch DJ Academy MIX! limits the length of songs that it will import to a minimum of 20 seconds and a maximum of 20 minutes. A song must also contain at least 12 bars of music to be imported. The supported audio file formats are AAC (.mp4), ALAC (.mp4), MP3, WAV, and AIFF. Files must be 16-bit mono or stereo at 44,100 Hz sample rate. Scratch DJ Academy MIX! only uses tempos between 60 BPM and 180 BPM. Tempos that fall outside of this range will be scaled up or down to a value that works best for beat matching.

**Search**

The Search utility (B) allows you to find songs by track name, artist, BPM, key, comments, or genre. Use “All” to search all of these fields.
List View Options

Right clicking in the Library list’s header will show all of the song information that can be displayed in the list. Checked items will appear with their own column. Most of this information can be edited for each track by using the Song Information window (see page 31).

![List View Options](image)

Sorting

Clicking on any column header in the Library list allows you to sort your songs by that parameter in ascending or descending order. Clicking repeatedly on the header toggles the direction of the sort.

Auto-upgrade

If a future version of the software adds new information fields or improves the BPM or key detection, Scratch DJ Academy MIX! will automatically re-analyze all the songs in your library to bring them up to date. This may take some time if you have a large library. You may choose to skip the BPM or key update if you are already happy with the results in the library or have edited the results manually.
Creating Playlists

The Playlist pane is where you drag songs from the Library to be played in sequential order. You can change the order of your playlist by dragging songs within the list, and you can play any song in the list by double clicking on it. A red box around two songs indicates that the mix between these songs is selected for editing (see page 20: Using the Mix Controls).
Hints

Selecting a song in the Playlist will highlight its BPM and Key along with any BPM or Key from compatible songs in the Library (assuming that Show Hints is enabled in the General page of the Preferences window). The range of BPM which makes a song compatible can be set in the Preferences window, as can the selectivity of the key matching. This feature helps you figure out which songs might mix well together — just like professional DJs do before their live sets.

BPM Matching

Scratch DJ Academy MIX! automatically matches the tempo of the two songs in a mix. The second song in the mix is sped up or slowed down to the same BPM (Beats Per Minute) as the first song. The closer the original tempos of the two songs, the better the mix may sound. The second song will slowly ramp its tempo to its original BPM over a period of eight bars after the mix. Visit the “Scratch DJ Academy Lessons…” Help menu feature for more information on BPM (see Section 13).

Key Matching

Harmonic mixing is the process of mixing together songs that are in the same or related musical keys. Electronic DJs practice harmonic mixing, as do many hip-hop and rock DJs. Harmonic mixing ensures that the pitches of all songs in a mix are complimentary. This will make your transitions smoother and make sure that your songs work well together.
The mix hints in Scratch DJ Academy MIX! will show all songs with the same key, as well as keys within one position (up, down, left, or right) on the chart below. For example, a song detected in C Major or C will match songs in A minor (down), F Major (left), and G Major (right). A minor is known as the “relative minor” key of C, and it shares C’s key signature. F Major and G Major are the keys a fifth

![Circle of Fifths](image)

With “Advanced Key Hints” enabled (in the General Preferences window), Scratch DJ Academy MIX! will also show matches for keys one diagonal position away. So for C Major, that would also include D minor and E minor. These are the relative minor keys of the subdominant and dominant, and they share their key signatures.

**Genres**

In some cases matching songs within the same genre or compatible genres may help to create a good playlist. Hip-hop songs may match well with each other, and hip-hop songs may also mix well with R&B or funk songs, for example. This is partly because genres are often recorded in similar BPMs or keys. You’ll also notice that many hip-hop and electronica songs have consistent tempos but live music tempo can change throughout the song. Scratch DJ Academy MIX! will help you manage tempo changes through its automatic beat matching feature.

You can enable viewing of the Genre column in the Playlist and Library list (see “List View Options” on page 16). Visit the “Scratch DJ Academy Lessons...” Help menu feature for more information on Genres.
Using the Mix Controls

The Mix Controls pane allows you to fine tune the mix transitions between the songs in your playlist.

Mix #

The Mix # control (A) selects which mix transition is currently being edited. This mix is shown by a red box around its songs in the Playlist, with a matching red box around the mix transition itself in the Arrangement (see page 23).

Mix Point

The Mix Point (B) is the number of bars from the end of the first song to where the second song begins to mix in. The Mix Point control contains a fixed set of common mix points. A Mix Point value with an asterisk next to it is a custom value set graphically in the Arrangement.
Mix Length

The Mix Length (C) is the number of bars for which both songs actually mix (overlap one another). The second song begins to mix in at the Mix Point, and the first song finishes its mix out when the number of bars selected in the Mix Length window is completed. The Mix Length control contains a fixed set of common mix lengths. A Mix Length value with an asterisk next to it is a custom value set graphically in the Arrangement.

Since a mix can not go beyond the end of the first song in the mix, some Mix Length values may be grayed out depending on the Mix Point. In other words, the Mix Length can never be greater than the Mix Point.

Scratch FX

The Scratch FX control (D) allows you to add pre-recorded scratching effects, which have been created by professional DJ instructors at Scratch DJ Academy, before the mix. Scratch effects can be between one beat and four bars long, and the effects are displayed graphically in the Arrangement. The scratch effects feature different types of sounds so you can match the best overall fit with the song you are playing. Scratch DJ Academy MIX! automatically matches the speed of the scratch effects to the tempo of your song — just like a professional DJ would do when performing live.
The “Customize Scratch FX…” menu option gives you complete control over the scratch parameters and allows you to listen to the scratch effect by itself.

Cue

The Cue control (F) is a fine adjustment for the Mix Point. Using the Cue control you can slide the mix up to 2 beats forwards or backwards in time in 1/32 beat increments. This allows the mix to begin at any point within a musical measure and gives you detailed control of the automatic mixing feature. Professional DJs often make slight, manual adjustments when performing live. No computer can replace the accuracy of a DJ’s trained ear, so there is sometimes a need for this manual adjustment.

The minus button (E) and plus button (G) adjust the cue backwards and forwards by 1/32 beat.
Preview

The Preview button (H) allows you to audition the currently selected mix transition. Playback will begin two bars before the mix, and it will play through the mix until two bars afterwards. If you make a change to any mix parameter while the preview is playing, the preview restarts so you can hear the full transition.

Record Mix

For the Record Mix button (I), see Section 11: Recording Your Mix (Exporting)

Using the Arrangement Timeline View

The Arrangement view gives you a graphical representation of your entire playlist, and it allows you to graphically edit the song transitions in that playlist.

Waveform Clips

Each song is displayed as a waveform clip (A) in the Arrangement. This clip shows the unique amplitude of the audio waveform over time, with time progressing left to right within the clip. The song's name is displayed in the upper left corner of the clip.
Selected Mix Region

As an alternative to the Mix # control in the Mix Controls, a mix region can be selected for editing by clicking in the grey area where two songs overlap in the Arrangement (F). The currently selected mix region will be enclosed in a red box (B).

Playback Marker

The Playback Marker (C) is a vertical orange line in the Arrangement which shows the current position which is being played or will be played from the Transport Controls (see Section 9). The Playback Marker can be manually repositioned by clicking and dragging on the tab at the top of the marker or simply by clicking anywhere in the tab’s track (D) or in any free space in the Arrangement pane.

Timeline

The Timeline (E) at the bottom of the Arrangement pane shows the overall time reference for all the songs within the playlist. You can zoom time in or out by clicking in the Timeline and dragging the mouse up or down.

Zoom Slider

As an alternative to clicking and dragging in the Timeline, you can zoom time in or out by dragging the Zoom Slider located below the Arrangement pane on the left.
Scratch FX Indicator

If a mix has a scratch effect (FX), the effect will be shown as a grey box with a turntable icon in front of the mix. The width of the box shows the duration of the scratch.

Dragging Waveforms

When a mix is selected for editing, positioning the mouse over the mix point or inside the second song of the mix will result in a hand cursor. Clicking and dragging will allow you to “slide” the second song over the first -- changing the mix point. At high zoom levels dragging will also change the cue adjust setting. On lower zoom levels, dragging will snap to the mix point in bars. Values which are not standard settings in the Mix Point control will appear in the control list with an asterisk next to them.

A mix point can be no greater than twelve bars after the previous mix in the playlist, in order to allow time for the song to ramp to its final tempo and for a scratch effect to be inserted. Dragging will stop at the boundary of this twelve bar buffer period. Since the mix length can not extend beyond the end of the first song of the mix, the mix length will automatically shorten when dragging past the end of the song.
Dragging Mix Length

When a mix is selected for editing, positioning the mouse over the end of the mix will result in a left-right arrow cursor. Clicking and dragging allows you to adjust the length of the mix. Values which are not standard settings in the Mix Length control will appear in the control list with an asterisk next to them.

The mix length can not extend beyond the end of the first song of the mix. You also can not extend a mix further than twelve bars before the following mix in the playlist. Dragging will stop when either of these boundaries is reached.

Transport Controls

Stop

The Stop button (A) stops playback and rewinds the playback counter to zero.
Rewind

The Rewind button (B) jumps backwards in playback.

The left arrow key is a keyboard shortcut for the Rewind button.

Play/Pause

When playback is stopped, the Play button (C) starts playing the playlist at the current time counter position. When the playlist is playing, you can press the Play button again to stop playback without changing the counter.

The spacebar is a keyboard shortcut for the Play button.

Fast Forward

The Fast Forward button (D) jumps forward in playback.

The right arrow key is a keyboard shortcut for the Fast Forward button.

Volume

Clicking on the Volume button (E) pops up a volume slider which controls the output level of all playback in Scratch DJ Academy MIX!

Pickup Cursor

The Pickup Cursor button (F) shows the state of automatic scrolling to the playback position while playing. If auto scrolling is disabled, pressing the Pickup Cursor button will cause the Arrangement to scroll to the Playback Marker and begin auto scrolling from there.

Scroll Slider

The slider below the transport controls (G) shows the playback position within the playlist or within single track audition. You can also change the play position by dragging the slider.
Display Contents

The display area to the right of the Transport Controls (H) is divided into two sections. The time counter shows the current playback position in either the playlist or in single track audition. The time is displayed in “hours:minutes:seconds” format. The text display below the time counter shows whether the playlist or a single track is now playing and gives the name of the currently playing item.

Saving and Recalling Your Work

Your current playlist and all of its mix information can be saved into a file called a Mix Session. To do this, select “Save” or “Save As” from the File menu. You can likewise recall previous mixes by choosing “Open” from the File menu and selecting the appropriate Mix Session (.msf) file. When exiting Scratch DJ Academy MIX!, you will be prompted to save any unsaved work.

If you attempt to load a session file that contains songs which are not found in the Library, you will be prompted to find those songs on your computer. If these songs are then successfully added to the Library, they will appear grayed out in the Playlist and Arrangement until their import analysis is complete.
Recording Your Mix / Exporting

Once your playlist has been constructed, you can record it to a single file using either the Record Mix button in the Mix Controls or the “Record Mix to File…” selection in the File menu.

Record Mix Options

The first step in recording your playlist is to select the audio file format in which to record your file. In the Record Mix Options dialog you can select either MP3 or WAV as your file type.

Saving the File

After pressing “OK,” you will be prompted for the location in which to store your file. You can also set the filename, which will default to the name of your mix session file.
Now, the recording process will begin, and you will be presented with a dialog showing its progress. Note that this will take a significant amount of time for a long playlist.

![Record To File dialog]

**Mix Vault**

Your recordings are automatically added to the Mix Vault when they are completed. The Mix Vault is a global repository of all the mixes that you have created. You can also drag the completed mixes into other music software tools, such as iTunes.

![Mix Vault window]

You can listen to a mix by double clicking on it, and you can edit its Song Information by right clicking (ctrl-click for Mac).
Song Information Window

The Song Information window gives you control of the stored metadata Scratch DJ Academy MIX! saves for every song in your library. You can access the Song Information window by right-clicking (ctrl-click for Mac) on any of the songs in the Library or the Playlist view. You can also double-click on the song’s waveform in the Arrangement view to access the Song Information.

Previous, Next, OK, Cancel

The Song Information window has four buttons along its bottom - Previous, Next, OK, and Cancel. The OK and Cancel buttons close the window, either saving any changes within the window or discarding changes respectively. The Previous and Next buttons OK any changes in the window and then edit the Song Information for the previous or next song in the list.

Info Editor (Tags)

The Info tab in the window edits “tag” information stored in the audio file.

You can edit the Track, Artist, Album, Comments, Year, and Genre tags of the song. The File Location field cannot be changed.
Mix Settings Editor

The Mix Settings tab gives you an advanced look at the mix information Scratch DJ Academy MIX! detects for each song. It includes a graphical representation of the song with a few more details than the Arrangement. Here you can correct or adjust when Scratch DJ Academy MIX! did not detect the BPM or Key correctly. You can also adjust the song’s starting offset to personalize your playlists a bit further.

BPM and Tap Feature

Beats Per Minute - You can manually edit the BPM setting (A) by typing in the BPM (if you already know it). Scratch DJ Academy MIX! will re-analyze the song to adjust where the beats and bars occur based on the new BPM.

You can also “Tap” in the BPM using the spacebar by clicking the TAP button (B) and following the instructions given in the window.
The “÷2” and “x2” buttons (C) will divide or multiply the current BPM setting by two. This is helpful if the automatic tempo detection returns a value which is off by a factor of two or if you want to do a mix transition with a “half time” or “double time” feel. Note that these buttons are only enabled if the resulting tempo will fall within the program’s limits of 60 to 180 BPM.

**Groove**

The Groove selection box (D) lets you inform the beat analyzer how strictly the tempo is followed throughout the song. Electronic songs with a steady drum machine beat may benefit from a “Tight” Groove analysis. Conversely, live rock songs with a varying tempo may need a “Loose” Groove for the most accurate beat detection. The majority of songs, however, are well served by a “Normal” Groove setting.

**Key**

The Key selection box (E) lets you correct the musical key if Scratch DJ Academy MIX! detected it incorrectly.

**Restore**

The Restore button (F) tells Scratch DJ Academy MIX! to revert all of its current settings back to what was detected when the song was first added to the Library.

**Show Bars**

The Show Bars toggle button (G) will enable the display of red lines in the waveform to show where the start of each musical bar has been detected. Scratch DJ Academy MIX! uses these locations as the “Mix Points” when you create your mixes.
Transport, Preview Song

You can preview the song in the Mix Settings editor by clicking on the Play button of the transport (J). Playback will start at the song's current First Bar Start Indicator (H). When playback starts, a Beats and Bar Counter will display in the transport and count up. This can be a helpful indicator for you to know that the BPM setting is correct by counting the beats along with what you hear (count on the beats -- 1, 2, 3, 4, 1, 2, 3, 4 and so on…).

The Playback Marker (I) shows the current playing position and can be repositioned by dragging, just like in the waveform view of the main interface.

First Bar Indicator, Song Start Offset

The First Bar Indicator (H) is displayed in green and shows you where Scratch DJ Academy MIX! thinks the very first musical bar occurs. This is also known as the “1” Beat. This offset position will be used as the beginning of the song when mixing in your playlists. You can adjust this marker by dragging in either direction to hear more or less of this song while mixing. Scratch DJ Academy MIX! will then use the new First Bar setting for any mix that includes this song. See “Scratch DJ Academy Lessons...” in the Help menu for more details on the “1” Beat.

Zoom Slider

Drag the Zoom Slider to see a closer view of this song's beat and bar positions. Zoom out to see more of the song at once.
Tutorial: Graphically Setting the “1” Beat

Although the beat detection algorithms used in Scratch DJ Academy MIX! are very advanced technologically, they can not always match the fine resolution that the human ear can discern when aligning beats in songs. As an example, if we zoom in all the way on the waveform of a song with a strong kick drum downbeat, we might find that the “1” Beat is shifted slightly into the kick drum waveform instead of sitting at the very beginning of its attack.

In this case, dragging the green First Bar Indicator allows us to align the beat with the very beginning of the kick drum attack.
This also offsets all the subsequent bar lines in the song by the same amount, hopefully bringing the beat map into better alignment and ultimately producing a tighter mix.

Another issue is that Scratch DJ Academy MIX! automatically attempts to place the “1” Beat after any introduction to the song, so that each mix will begin with the song’s first strong rhythm. However this might not always be the best place to start your mix for any number of artistic reasons. The First Bar Indicator can also be dragged longer distances in order to select the starting point that best suits your mix.
Scratch DJ Academy Lessons

The Scratch DJ Academy Lessons feature, located in the Help menu, provides beginner information about Mixing, Scratching, and Music Theory derived from the curriculum of the world famous Scratch DJ Academy (www.scratch.com). There is also a Community page which provides links to various online resources of the Scratch DJ Academy and Stanton user communities.

This window will automatically open the first time that Scratch DJ Academy MIX! is launched.
Preferences

Setup parameters for Scratch DJ Academy MIX! can be edited in the Preferences dialog in the Edit menu on Windows or in the “Scratch DJ Academy MIX!” menu on the Mac.

General

The General preferences window edits assorted user definable features.

DJ Name

The “DJ Name” is the name that will be used as the Artist for any mixes recorded in Scratch DJ Academy MIX! When selecting a DJ name: Be creative and be you!

Show Hints

The “Show Hints” checkbox enables the Mix Hints feature when selecting songs in the Playlist. Mix Hints highlight compatible BPMs and Keys in the Library for the selected song.
The numeric entry box sets the BPM range for compatible tempos in the Mix Hints. Any tempo in the Library within plus or minus this value from the tempo of the song selected in the Playlist will be highlighted. Five BPM is a good starting point for this value.

The “Advanced key hints” checkbox enables looser key hint matching to allow more possible harmonically related songs to be highlighted. See “Key Matching” in Section 6 or the “Scratch DJ Academy Lessons…” feature in the Help menu for more information on harmonic mixing, musical keys, and key hints.

Autoscroll to Playback Marker

The “Autoscroll to Playback Marker” check box enables the automatic scrolling of the Arrangement pane to follow the Playback Marker while the playlist is playing. If this feature is disabled, you can still manually force the Arrangement to follow the Playback Marker using the Pickup Cursor button in the Transport Controls (see page 26).

Tags

The Tags preferences window allows the writing of analyzed song information to a song file’s “tag” metadata so that it can be shared with other programs.
**Write to BPM Tag**

The “Write to BPM tag” check box enables the writing of the song’s BPM information to the song file’s tempo tag. These tags are fairly standard and can be read and edited by most other music software.

**Write to Beginning of Comments Tag**

The “Write to beginning of comments tag” check box enables the writing of the song’s key information as text at the beginning of the song’s comment tag. Comment tags are fairly standard and can be read and edited by many music programs.

**Write to Key Tag**

The “Write to key tag” check box enables the writing of the song’s key information to the song file’s key (or “initial key”) tag. These tags are not as widely supported, so you may wish to store the key information in the comments tag as well if you want to see it in other music software.

**Audio Setup**

The hardware setup for audio playback is configured in the Audio Setup preferences window.

![Preferences Window](image)

- **output:** Primary Sound Driver
- **active output channels:** Left + Right
- **sample rate:** 44100 Hz
- **audio buffer size:** 2048 samples (46.4 ms)
Output

Output selects the hardware driver for the device which will play your audio.

Test

The Test button creates a test tone, helping to determine where the audio is being routed in your system.

Active Output Channels

The Active Output Channels list allows you to enable and disable channels on a multi-channel audio interface.

Sample Rate

Sample Rate selects the clock speed at which your audio will play back.

Audio Buffer Size

Audio Buffer Size selects the size of the memory buffer used to output your audio. If you notice audio problems during playback, you should try increasing this number until audio plays back smoothly.
More Help and Contact Us

Visit www.sdamix.com for technical support, breaking news on Scratch DJ Academy MIX!, information on new software versions, and FAQs.

For direct technical support questions, send an email to support@scratch.com.

For more information on Scratch DJ Academy, visit www.scratch.com or send us an email to info@scratch.com.

For more information on Stanton DJ Products, visit www.stantondj.com.

Credits & Information:

• Produced by Scratch DJ Academy and Stanton Magnetics, 2010-2011

• Developed in New York, NY at Scratch DJ Academy

• [tONaRT] Key Detection Technology by zplane.development

• [aufTAKT] V3 Tempo and Beat Detection Engine by zplane.development

• This software uses libraries from the FFmpeg project under the LGPLv2.1 (Windows only).

• This software uses libraries from the LAME project.

You must accept all terms of the End User License Agreement to use MIX!. If you accept all terms of the agreement, click “I Agree” to continue when installing the MIX! application. If you don’t agree to all terms, please click “Cancel” to return to the www.sdamix.com home page.